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Thank you for purchasing The Dungeon Revealed. If you are 
familiar with its forerunner, The Dungeon of Doom, you probably 
couldn't resist. If not, you are about to begin one of the most playable, 
habit-forming games available for the Macintosh. 

Why The Dungeon Revealed ? Because now two other items are 
available which remove some of the mystery. The first is a booklet, 
The Carnos Chronicles, which provides clues and tips for playing the 
game. The second is the source code (hard copy format) for the game 
itself. If you are interested in how a game like The Dungeon Revealed 
is programmed, the source code is ... well. .. an excellent source. It is 
only available to registered buyers of the game and can only be 
ordered from Woodrose Editions. 

Included in your package is a buyer registration card. Please 
complete and return this card immediately to insure prompt support, 
should it be required, and prompt handling of your order for the source 
code if you order it later. This will also guarantee that you be among 
the first to receive new product and/ or upgrade announcements. 

Welcome to The Dungeon Revealed .... 

This guide assumes you are familiar with the operation of your 
Macintosh. If you are not, you should study your owner's manual 
before proceeding with The Dungeon Revealed. The game has been 
tested on the Macintosh XL (no digitized sound, however), 512K, 
512K Enhanced, Plus, SE and Macintosh II (only the "QuickDraw 
Mode" will work on a Macintosh II). You should only run the game 
with the system software version 3.2 or later. The game will not run 
on the Macintosh 128K. 

The Dungeon Revealed disk you received is not a startup disk . 
The disk contains The Dungeon Revealed, a special Game Finder 
designed exclusively for use with The Dungeon Revealed (on 
machines with only one single-sided disk drive, there is not enough 
disk space for the game, a system file and the Apple Finder™), an 
example game file, and a Note Pad File. 

With only one single-sided drive, you must set up a TOR startup 
disk with a minimal System Folder-a 3.2 system file with only the 
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system fonts (Chicago 12, Geneva 9 and 12, Monaco 9) and the Note 
Pad desk accessory, plus the Game Finder, game file and Note Pad 
File provided (the Game Finder is named "Finder" so you don't have 
to set it as the startup file). Begin with a blank, initialized single­
sided disk, and copy a ''bare bones" system file to it as described 
above. Next, from your master disk, copy The Dungeon Revealed, the 
"Finder," the game file and Note Pad File to your disk. If you get an 
alert saying there is not enough room for the files, be sure you are 
starting with an initialized disk, and be sure there are no unneeded 
desk accessories, fonts or FKEYs installed in your system file. 

If you have two drives (either single-sided, double-sided or 
both), or a hard disk, it is not necessary to use the Game Finder, but 
you may wish to use it just the same, since it requires little space and 
displays some of the artwork from the game. Simply copy The 
Dungeon Revealed to a working disk or hard disk (don't use your 
master for playing) and allow SOK for one game file, which is created 
when you start the game. Under HFS, all TOR-related files must be 
in the same folder or in no folder at all. 

The first thing you should do is make a working copy from the 
master, then put the master away in a safe place, in case your 
working copy is damaged. Do not start running the game from your 
master disk! To make a working copy, insert the master disk you 
received, then follow your manuals' instructions for copying the files 
either to a floppy disk or hard disk, as described above. Read this 
guide and familiarize yourself with the basics of The Dungeon 
Revealed, and your journey will begin! 

The Dungeon Revealed is programmed to run in either of two 
modes: QuickDraw or FastDraw. QuickDraw mode is intended for 
the Mac II and big screens (The Big Picture™, MegaScreen™, etc.), and 
FastDraw mode is for Macs with the standard screen. The only 
difference is that QuickDraw mode creates a movable game window 
which can be repositioned on big screens. FastDraw mode does not 
function on the Mac II--0nly QuickDraw mode will open. On other 
Macs with standard screens, both modes will run, but FastDraw mode 
offers better performance, and QuickDraw's window cannot be moved 
on a standard screen anyway. FastDraw mode will run on big screens 
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and will offer slightly better performance, but the game window is 
"locked" in the upper left comer of the screen. 

Tum on your Macintosh and insert your working copy of The 
Dungeon Revealed. If your working copy is on a hard disk, this of 
course won't be necessary. Start the game by selecting the game icon or 
game file icon and choosing "Open" from the File menu (or simply 
double-click on the icon). As shipped, The Dungeon Revealed will 
launch in FastDraw mode, unless you are using a Mac II. If you are 
using a big screen and would like the movable window, simply hold 
down the Option key as you launch the game (hold down the key 
until the game is fully launched), and it will open in QuickDraw 
mode. The Option key "toggles" between modes-in other words, 
unless you hold down the Option key the next time you run the game, 
it will again open in QuickDraw mode. In QuickDraw mode, the game 
will begin as usual, with the playing window in the center of the 
screen. Using the pointer, you can then position the window like any 
other, by clicking on the title bar and dragging. For optimum 
performance and speed control during play, hold down the Option key 
as you click on the title bar and move the window. This causes the 
window to snap to alligned copybits, which allows the game to run at 
its best on a big screen. Moving the window without holding the 
Option key allows positioning anywhere, but if the window does not 
land on alligned copybits, speed control (set with the number keys on 
your keyboard) will degrade. If, of course, you don't mind playing the 
game at a slower pace, this may not be a problem for you. 

"When The Great Ascham and his people first settled this land, 
they brought with them the Orb of Camos, a brilliant, mystical 
sphere which instilled harmony and abundance throughout the 
Kingdom. For many years, our crops flourished, and the people lived 
in peace, prosperity and happiness. 

"Then, from out of the Twilight Regions, a Dark Wizard brought 
himself. He descended upon Ascham's castle and raided the sacred 
chambers, pillaging all, including the Orb of Camos. Since that day, 
nothing in our homeland has been as it was. The crops and herds are 
befallen with blight and disease. The seasons no longer follow their 
proper course. The people fight among themselves for the most petty 
of reasons. 
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"Without the enchantment of the Orb, our Kingdom is sure to see 
its end. Thus, The Great One appeals to you: Send forth your best to 
the Dark Wizard's dungeon. Seek out your noble, brave and wise­
your dexterous, powerful and intelligent. The Orb must be returned!" ,. 
*From the introduction to The Carnos Chronicles, a booklet of clues to The 
Dungeon Revealed, available separately from Woodrose Editions. 

Launch The Dungeon Revealed as described above. As the game is 
loaded, you see the "welcome" screen. Allow a few seconds for this. 

Click the mouse-the welcome screen zooms away. Select "New" 
from the File menu, and you are presented with the following 
window: 

.Select cf)1u·actec:S oaroe ao~ cfa,s,.s: 

I (("f)e ~me 1{1Jlg"fJt 

@Knight 
.St ceogtf): .16 

0 Fighter (oteHLg eoce: .10 
0 Sage 

UJl,.S~OfJJ: .10 
0 Wizard 

~e~tecLtq: .16 
0 Rlchemist Col)S tl tc.tloo: .18 
0 Jeweller 

CfJa ct..sroa: .15 
0 Jones 

~ Onward!~~ ( Cancel ) 

By clicking on the different buttons next to each type of character, 
you can compare their various traits, which are shown at the right. A 

4 

t 

character's attributes control how well he can do certain things. All 
attributes range from zero to twenty-five, with twenty-five being the 
best. Strength controls how many things a character can carry and 
how much damage he does when hitting a monster. The other 
attributes help characters in different ways. Choose the character 
you want, then type in the name you want your character to go by. 
When you are ready, click the "Onward!" button (or press Return). 

Next, you will see a dialog box for saving your game. The default 
name for your game file is "Game File," but you can type in whatever 
name you want. If you plan to play different games as different 
characters, it may be helpful to name the files according to the 
characters, such as "Knight," "Fighter," and so on. Keep in mind that 
each game file requires SOK of disk space. Depending on your system, 
you may have to keep game files on more than one disk. Be sure you 
have at least enough space available to save one game. You can't 
continue without naming a game file to be saved . 

I (g) TOR I 
<ii HH~ Dun9<rnn fl(W<rnl<~d Q lg) TOR 

( Eject ) 

( Driue ) 

0 
Saue new game as: ( Saue ~J 

I Blue Knight I ( Cancel ) 

Click "Save," and you are underway! The playing window first 
appears like this, with your character at the center: 
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Your pointer becomes a sword in the dark area. Click outside the 
character icon, or press a movement key (see below). 
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You now enter dungeon level 1. To move through the dungeon, you 
can simply put the pointer in the direction you want to go and press 
the mouse button, or you can use the keyboard: 

To change direction when using the mouse for movement, just 
move the pointer to the direction you want. Before you move around 
much, you may want to prepare as best you can. Each character begins 
with a few items in his pack, but none are in use. Press the S key (or 
choose "Display Status" from the Control menu); no items are listed. 
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To see and use the items you have, check the "Wear ... " and 
"Wield ... " commands in the Use menu (more information below). 

In the example, the Knight is on level 1, near the stairway 
leading out. The "up" stairways are identified by the light at the 
other end; the "down" stairways are dark. To climb or descend a 
stairs, move the character next to it, then click on the stairway or use 
the appropriate movement key. Knowing you start on Level One, at 
the bottom of the "up" stairs, try to escape by climbing the stairs, 
then look for a message in the area to the right of the playing 
window. It seems you have some work to do! 

,Sti-:16 
t1Jt:.io 

wt,,s:.io 
'De~:.16 
Coo:.ia 
Gf)e:.is 

Jol~:.io ~L:o 

In this window, to the right of the playing window, you see your progress. At 
the top, your movement around the dungeon is traced; your attribute levels, 
dungeon level (DL), experience level (EL) and hit point values (HP) are 
displayed. Below that are two indicators, one for your hit point status (HP) 
and one for your food level (FD). Here, the character is fully healed, and the 
food level is near three-fourths maximum. As your situation deteriorates, anc 
as you get hungrier, the gray recedes to the left. In the scroll · at the bottom, 
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you are kept informed of what takes place-the monsters attacking, etc. 

Your total hit point value depends on your experience, which you 
gain by killing creatures. The deeper you go, the more experience each 
monster is worth, and the more hit point damage it inflicts on you. 
The hit point bar may remain the same size, but your actual number of 
hit points rises each experience level. Each experience level is 
harder to reach than the previous one, but as you gain experience, you 
can do nearly everything better. 

You won't have to go far to find objects. In the example, a mace 
and food sack are immediately visible. The objects available are 
very important to you, and you soon develop skill to use them wisely. 

New ... 

Open ... 

Close ... 

Open ..• 
Close 

Snue 
Seue Rs ••• 
Saue e Copy As ••• 
Reuert 

Transfer ••• 
Quit 

Creates a new character and game file. If 
you are playing a game, you will have the 
option to save it before creating the new 
character. You must have at least SOK of 
free disk space to create a new game file. 
Restarts a game that was saved. The 
effects of this command on the game in 
progress are the same as for "New ... " 
Oases the game in progress without 
quitting the application. If a desk 
accessory window is at front, this closes it. 
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Save Saves the game in progress. Note that the 
game is saved automatically whenever a 
character goes up or down a stairs, so this 
is only necessary to save progress made 
while exploring a level. 

Save as... Saves the state of the game in a new file, 
which then becomes the current game. The 
original game, with its original name, 
remains as it was when last saved. 

Save A Copy As... Saves the state of the game in a new file, 
but you continue the original game with no 
changes saved. 

Revert - Restores the game to the state of the last 

Transfer ... 

Quit 

save. 
Quits The Dungeon Revealed and bypasses 
the Finder™ to another application. 
Quits The Dungeon Revealed. 

When you choose "Transfer ... " to go to another application, a 
dialog box appears. 

I (g) MncPalnt I 
~ MacPaint ~ (g) MncPolnt 

Eject 

Driue 

Trnnsfer 

Rttnch 

Cancel 

Select the application you want and click "Transfer," or double­
click the application name. If you select the application and then 
click the "Attach" button, another box appears: 
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I~ MacPaint I 
D Picture 1 ~ 

D Picture 2 
(g) MacPaint 

Eject 

Driue 

Open it] 
Cancel ) 

Here you can attach a document to open also. If you are 
transferring to an application that can open documents created by 
other applications (e.g., SuperPaint™ can open a MacPaint™ 
document), you can press the Option key, and all documents are 
displayed. You can now select the one you want to open, but be careful 
to select a document compatible with your transfer application. 

Cut :•:H 
[ O(H.j :•:c 
f>ns1e :•:ll 
( h~llt' 

Bring Other Windows to Front 

The first five commands under the Edit menu only function with 
desk accessories. If a desk accessory window is hidden behind the 
game window, "Bring Other Windows to Front" will make it visible 
again. 
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Pickup mode 

Display Status 

Sound 
Pause 

Adjust Volume ... 

--· Lt•• RI 

Pickup Mode 

Display Status XS 

Sound 
Pause 

---· 
Adjust Uolume ... 

When this is checked, objects are 
automatically picked up when the 
character passes over them. If unchecked, 
objects must be picked up with "Get an 
Item ... " in the Inventory menu. 
Shows weapons, rings and armor the 
character is using. 
When checked, the sound is on. 
Pauses the game until you are ready. After 
a couple of minutes' inactivity, a built-in 
screen saver activates. 
Use this instead of the Control Panel to set 
the volume. When you quit the game, the 
sound will return to its original setting. 

Drink Potion... 3€0 
Re11d Scroll... XR 
Z1tp W1tnd... XW 
Throw Item... XT 
E11t Food... XE 

llle<1r flm1<1r... :•:ll 
llle~1r Ring.. . :•:.J 
Wield We11pon... XM 

Remoue Armor... XY 
Remoue Rings... XH 
Remoue We11pons... XN 
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The Use menu is where you control the use of the objects you've 
picked up. Selections are dimmed, as shown above, if you have no 
objects of that type. 

Drink Potion ... 

Read Scroll ... 

Zap Wand ... 

Throw Item ... 

Eat Food ... 

Wear Armor ... 

Shows a list of the potions you have. 
Select those you want to drink. All potions 
have a use value of+ 1, meaning they can 
be used only once. 
Shows a list of your scrolls. Select those 
you want to read. The use value on 
identified scrolls tells how many times 
the scroll can be read. For example, an 
Identify Scroll +4 can be read four times. 
Shows a list of your wands. Select those 
you want to zap. When you click "OK," 
the game waits for a zap direction, which 
can be given with a mouse-click or a 
movement key. To abort a zap, press a non­
movement key or click in an area where 
your pointer is not a sword. The use value 
for wands works the same as for scrolls. A 
Fire Wand +6 can be used six times. 
Shows a list of your throwable items. 
Select those you want to throw. Throwing 
direction is given the same way as wand­
zap direction. The use value indicates how 
many times an object can be thrown before 
it breaks. An object will be thrown farther 
and with greater force if you wield a sling. 
To abort a throw, press a non-movement 
key or click in an area where your pointer 
is not a sword. 
Shows a list of your food. Select the 
rations you want to eat. The use value tells 
how many meals are in a sack. 
Shows a list of your armor. Select the 
armor you want to wear. The use value 
indicates the level of magic in the armor, 
not the number of times it can be used. 
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Wear Ring ... 

Wield Weapon ... 

Shows a list of your rings. Select the rings 
you want to wear. The use value for rings 
has different meaning for different rings, 
but generally, a positive value is better 
than a negative one. Some rings may never 
have a use value; some may do nothing 
unless they do have one. Each ring is 
unique. 
Shows a list of your weapons. Select those 
you want to wield. Use values are similar 
to those of armor. A Long Sword +4 will 
hit more often and do more damage than a 
Long Sword -1. Some weapons take more 
than one hand to use. 

When issuing commands in the Use and Inventory menus, dialog 
boxes similar to this appear: 

The "Remove .. . " selections in the Use menu show lists of the type 
of items selected that you are currently using. Select the particular 
items you want to remove, and they are placed in your pack. 
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•• llJ:.I 11111111! 

Get an Item ..• XG 
·----·--···-----.. ·-·····-···-··· .. -···-·····-· 

Drop an Item... XO 
Drop Scrolls 'md Potions ••• 
Drop Rings and Wands •.. 
Drop Armor and Weapons .•• 
Drop Food and Other ... 

Drop ALL I terns 
Drop Last Items Picked Up XL 

lnuentory XA 

"Get an Item ... " shows the objects available on the square the 
character is standing on. Select those you want, and they go into your 
pack. "Drop an Item .. . " shows a list of all objects you carry, except 
those in use. Select the ones to drop, and they are placed on the square 
where you stand. The other "Drop ... " selections work the same way, 
but the lists show only the items specified ("Drop Food and Other ... " 
lists food, throwables, gems and orbs). "Inventory" shows a one­
screen, complete list of your objects; those in use are in outlined type: 

' w 
Potions: Armor: 
Magenta ~mmmrc@t 

1fil . 0 
Scrolls: Rings: 
Morgana ~ 

' / 
Yands: YeaP.ons: 
Bamboo ~~ 

/ ~ 
Throw ables:: Gems: 
Small rock Emerald 

a- • Food: Orbs: 
Food ration None 
Lizard 
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Fiie Menu 
Edit tmd Control Menus 
Use Menu 
lnuentory Menu 
General 
Keyboard Commands 
Rumors 

Hall of Legends 

While playing The Dungeon Revealed, some of the information 
covered in this guide is available under the Help menu, as well as 
additional information. 

"General" includes information on Special Class characters. 
Special Class characters can make educated guesses at what some 
things are in the game, and this ability causes some things to appear 
a bit differently. As the character gains experience, the guesses 
become more accurate. For example, a character picks up a Vellum 
Scroll and thinks it is an "Identify Scroll? +3?" Note the question 
marks. They indicate that this is only a guess, and it may be wrong. If 
the character reads it and finds it is an Identify Scroll, the 
description would change to "Identify Scroll +2?" He now knows it is 
an Identify Scroll, but he still doesn't know how many uses are left. If 
he reads the scroll and identifies an item, the question marks go 
away, and the object's true identity is shown. Some characters can do 
things better than others, but all characters can use and do 
everything. 

Rumors are rumors. But you may find them helpful in analyzing 
many aspects of the game. 

The Hall of Legends keeps track of scores (based on the loot a 
character held upon death or escape). It also tells the name and 
experience level of the character, on which level he perished (or if 
he escaped), and if killed, which monster did him in. 
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Where menu selections have a keyboard equivalent, it is not 
necessary to hold down the command key to activate them-just press 
the letter key. 

The speed of the game is controlled with the number keys one 
through zero, with one being the fastest and zero the slowest. 

The space bar can be used to speed time along during character 
healing or lulls in the action. Monster movement also speeds up, 
however. 

When selecting items from a list-such as a list of items to drop­
hold down the command key as you click to select several items that 
are not grouped. To select a range of items that are grouped, select the 
first (or last) item in the group you want, hold down the shift key, 
then click on the item at the other end of the group; all items between 
the two are selected. 

To erase the Hall of Legends, press command-backspace while it 
is displayed. 

If you are already familiar with the game, you know it takes 
practice to survive. If not, and if you manage to escape th~ dungeon 
without once being killed, you are doubtless a special breed. 
Remember, to get practice deeper in the dungeon, you can carry on a 
game even after your character has died, beginning from the last 
point at which the game was saved. Eventually, of ~ourse, yo~ hope 
to escape without once being killed. Then you can mdeed claim the 
title Dungeon Master, conqueror of the Dark Wizard! 

The Orb of Carnos G 
Wands 

Potions 

Scrolls 

Rings 

' ' ~ © 
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Gems ~ 
Food ~ 
Armor w ~ en ~ ~ fil 
Weapons~-,(~/ J!° ~ ~ 
Throwables ~ / ~ @ 0 
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